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Microsoft Excel 2007 
 

Excel is Microsoft’s Spreadsheet program. Spreadsheets are often used as a method of displaying 
and manipulating groups of data in an effective manner. It was originally created for accounting.  

 
Excel is useful when you have a very large set of data and need to perform the same operation on 

each Series / Set of it. It is well suited to tasks such as sorting, alphabetizing, adding 2 columns 
together, and performing more complex mathematical functions on data.  
 

 

Things to Note - Data types and Formula syntax 
 
General Tip  - Do not worry about having to start from Cell A1. You can start wherever you like as 

long as your data is in a solid block of adjacent cells. When you print, you can select a specific set of 

cells so that empty cells are not printed. 
 

Data Types - There are four different types of data that can be entered into a cell; they are: text, 

numbers, formulas and functions. These data are entered using the Formula Bar at the top of the 
screen but you’ll notice that what you enter into the Formula Bar and what shows up in the Cell may 

be two different things - especially when it comes to formulas and functions. 
** If the Formula Bar is not visible, turn it on by going under View >> Formula Bar  

 
Formula Syntax - It is very important to make sure that, when working with formulas, you have the 

correct syntax. Excel has its own mathematical syntax and, if this is used improperly, you will not get 

the correct results from you functions and formulas. Excel will only check for logic errors.  
 

 
Different versions of Excel and different installations on computers may have all kinds of shortcuts 
added, or even removed. For consistency’s sake, we’ll use the Ribbon Tabs to explain how to 

complete various tasks. 
 

 

Microsoft Interactive Online Demos 
 

Microsoft has developed a series of online demo programs to assist people with the transition to 
Office 2007. 
 

 Start the Guide for a program by clicking on that phrase on the webpage listed below 

 A new window will open in your web browser showing Office 2003 

 Use the familiar Toolbar from Office 2003 to find a Tool 

 A second window will appear to show you how to use the same Tool in Office 2007 

 
The web address for the Excel Guide is: 
 

 http://office.microsoft.com/en-us/excel/HA101491511033.aspx  
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MS EXCEL 2007 - New Interface 

 
When you open Excel 2007, you will notice that it looks quite different from Excel 2000 and Excel 2003. The 
same tools are all there, but they are arranged very differently and new features have been added.  
 
If you are already familiar with Excel 2000 or 2003, it may take you a while to adjust to this new arrangement of 
tools. This tutorial uses Excel 2007 and you can use it as a quick reference guide for most of the common 
tools. 
 

Arrangement of Tools in Excel 2007 

 

 

 
The MS Office Button contains the main file functions 

 New, Open, Save, Save as, Print, Print Preview, etc. 
  

The Quick Access Toolbar contains shortcuts to Save, Undo, and Repeat 
 

Each Ribbon Tab displays a Ribbon that provides a set of  
Tool Groups.  

 The Ribbon Tab and the Tool Groups in the Ribbon 
correspond to the Menu and Toolbar in Word 2000 and 

2003 
 The Name of each Tool Group is listed at the bottom of 

the Group 
o Example -  In the Home Tab, the second Tool 

Group is named Font 
o The name "Font" is under the Font Tool Group 

 

To change the Tool Groups being displayed in the Ribbon  

 Click on the appropriate Ribbon Tab 

 Example - The Home Tab contains Tool Groups for the most commonly used Tools 

o ClipBoard, Font, Paragraph, and Style tools in Word 
 

Some Tool Group boxes have a small arrow in the bottom right-hand corner.  

 If you click on this arrow, Word will open a Dialog Box which offers  
more options and settings related to that Tool Group 

 
In Excel 2007, tools with similar uses are organized so that they are usually found within the same Tool Group 
or at least within one Ribbon. If you do not find a tool in the Ribbon you think it should be in, try exploring the 
other Ribbon Tabs. 
 
In this tutorial, we will not use the control keys as these function differently on different computers. For the sake 

of consistency, all instructions in this tutorial refer to the Ribbon Tabs and Tool Groups in each Ribbon.
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Getting Started 

Start a new Workbook MS Office Button >> New 
 

When you open Excel for the first time, a new, blank Workbook appears. 
If you are already in Excel and want a new Workbook  
 Click on MS Office Button and choose New 
 
NOTE: In Excel, a Workbook is the basic document 
 

 Each Workbook contains several Sheets on which different sets of Data can be 

entered 
 The Sheets are listed at the bottom of the Excel window 

 Sheets can be given individual names 

 Click on the name of a each sheet to switch between them 

Open an existing 
Workbook 

MS Office Button >> Open 
 

 Browse to an Excel Workbook document and Open it 

Open a file from a 
different version or 
format 

Excel 2007 will automatically convert a document from a compatible version of Excel 
 

 Your document will open in Compatibility Mode 

 This will prevent you from using certain tools in Office 2007 which are not 
compatible with Office 2000 or 2003 

 When you finish editing a document, be VERY CAREFUL to save any converted 

documents in their original format 
 Please read the Important Notes below regarding saving in Office 2007! 

IMPORTANT NOTES:  Saving Documents in Excel 2007  
  
1. In the Computing Facilities, files on the Desktop are NOT SAVED when you log off. 

 ALWAYS use Save As... to save your file to a USB Flash Drive, UVicTemp, or CD 

 You can also save a file to the Desktop and then email it to yourself as an attachment 
 
2. If you are NOT running Office 2007 at home and you save a document as Excel 2007 (*.xlsx),  

YOU WILL NOT BE ABLE TO OPEN IT AT HOME! (see step 3 below) 

 
3. If you have Office 2000 or 2003 or you use a Mac at home or in the Computing Facilities 

 You will have to save your document as an older version 
 Go to MS Office Button >> Save As 

o At the bottom, there is a bar that asks you to “Save as Type:”  
o Choose Excel 97-2003 Workbook (*.xls) 

 DO NOT CHOOSE “Excel Workbook (*.xlsx)” 

 
4. If you are using a PC at home running Office 2000 or 2003 

 You can download the MS Office 2007 to Office 2003 Compatibility Pack from Microsoft's website 

o http://www.microsoft.com/downloads/ 
o Under New Downloads, choose "Microsoft Office Compatibility Pack for Word..." 

 Even with the Compatibility Pack, you might lose data / formatting when you save as an older version 

 There is no Compatibility Pack available for Mac yet. 

Save the current 
Workbook 
OR 
Save the Workbook 
as a different name, 
version, or format 

MS Office Button >> Save or Save As... 
 

 Please read the Important Notes above regarding saving in Office 

2007! 
 In the bars at the bottom of the Save As... Window 

 Give your document a new name in “File Name:” 

 Select the version and format from “Save as type:” 
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Formatting Data 

Insert Data into a cell Select a Cell by placing the cursor in the Cell 
 

 Type data into the Formula Bar at the top of the Excel Window 

 OR into the Cell directly 

 Data can be - Number, Text, Formula, or Function 

Home Tab - Font, Alignment, Number & Cell Groups 
 

 

Insert more Cells into 
a Sheet 

Home Tab >> Cells Group 
 

 Place the cursor where you want the Cells to be added or deleted 
 Choose the Insert or Delete Tool in the Cells Group 
 You can add Cells, Rows, Columns, or a whole new Sheet for Data 

Change the Type of 
Data within a Cell 

or cells  
(Ex:  increase decimal 
places) 

Home Tab >> Number Group 
 

Select the cell(s) you wish to format 
 Click on the pull-down menu at the top of the Number Group 

o If you move the mouse over this menu, it says Number Format 

 Assign a Data Type to the Cell(s) 

 "General" is the Default Data Type 

Change the Font of 
the Data in a Cell  

Home Tab >> Font Group 
 

 Select the cell(s) you wish to format 

 In the Font Group there are several Tools for altering the Font, Size, Colour, and 
Style of the Data in the Cell 

Change the Alignment 
of the Data in a Cell 

Home Tab >> Alignment Group 
 

 Select the cell(s) you wish to format 

 In the Alignment Group there are Tools for 
o Centring Data in Cells Horizontally and Vertically 
o Merging and Un-Merging Cells 
o Wrapping Data so that it continues to the next line within one Cell 
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Format Cells Dialog Box - (has not changed from Word 2000, 2003) 

 
 Allows you to change several properties of a Cell within one Dialog 

Box. 
o Type of Data 
o Alignment/Position of Data in a Cell 
o Font of the Data 
o Cell Borders and Fill 

 
 Offers more options than the Tool Groups in the Ribbon 

 
 It is especially useful for altering Cell Borders 
 

 

 To Open or Launch the Format Cells Box 
o Select the cells you wish to format 
o Click on the Dialog Box Launcher arrow at the right bottom corner of the  

Font, Alignment, or Number Groups 
 

 

Format the 
Borders of Cells 

Home Tab >> Launch Format Dialog Box 

(small arrow at bottom right of Groups) 
 

Select the Cell(s) you wish to format 

 Click on the Dialog Box Launcher arrow at 

the right bottom corner of the  
 Font, Alignment, or Number Groups 

 This will launch the Format Cells Dialog Box 

 Click on the Border Tab at the top of this Box 
1. Choose a Style of Line 
2. Choose a Colour for the Line 
3. Choose which Border Lines you want to 

see around the Cell(s)  

Format the Column 
Width or Row 
Height of Cells 

Home Tab >> Cells Group >> Format 
 

Select the Cell(s) for which you want to change the Row Height or 
Column Width 
 Click on the Format button in the Cells Group 

 Choose to adjust the Column Width or Row Height 
OR  

 Select Autofit to adjust the Cell to the size of the Data 

Move a cell(s)  Select the Cell(s) you want to move 

 Position the mouse over a border of the selection 
 The cursor will change from a thick white plus sign into thin crossed arrows 

 Click-drag the cells to their destination. 

Merge Cells 

Combine several 
Cells into 1 
 
NOTE: 
This process ONLY 

retains Data from 
the top left Cell 

Home Tab >> Alignment Group >> Merge & Center 
 

Select the Cell(s) to be Merged 

 Click on the Merge & Center Tool 

 Select Merge Cells from the pull-down 
menu 

OR 

 Launch the Format Dialog Box using 
the arrow at the bottom right corner of the Alignment Group 

 Check the Merge Cells box under Text Control. 
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Automatically fill 

Data Cells 
 

Excel can automatically continue a list if you provide the first 2 or 3 items in it. This is 
very useful for basic sequences such as: 

 Days of the week  

 List of numbers 
 

Input data into a Cell or across two consecutive cells to get an incremental list 
 Select the cell(s) 

 Position the mouse in bottom right corner of the selection 

 The pointer will change to a thin black cross 
 Click-drag downwards or to the right across the neighbouring empty cells to 

apply the Auto-fill to all desired cells 

Sorting Data Data Tab >> Sort & Filter Group >> Sort 
 

Select the Data in a Row or Column 

 Click on the Sort button to open the Sort 

window 
 
Home Tab >> Editing >> Sort & Filter 

For simple Sorting, use the Sort & Filter Tool in 
the Editing Group of the Home Tab 

Formulas - The Formula Bar & Functions 

Formulas are entered in the Formula Bar under the 

Ribbon.  
 
Formulas are composed of one or more Functions. 
 
Formulas: 

 Require an equals sign to begin '=' 

 Follow the rules of BEDMAS (see below) 

 Will be checked for Notation errors, not Logic errors 

 Rely on column/row numbering (A1, Z39) 

 Are most easily tackled by using the online help feature 

 

To begin a Formula: 
 

Select the Cell where you want the result to 

appear 
 This Cell does not have to be adjacent to 

the Data used by the Formula 
 

1. Type an equals sign '=' into either 
o The Formula Bar  

o The Cell where you want the Result to 
appear 

 

2. Choose a Function from the Function List 
to the left of the Formula Bar  

o This list contains commonly used 
Functions such as Add or Sum 

o For more functions, choose More 
Functions... 

o The Insert Function Dialog Box will 

open 
 

3. The Result of the Function will appear in the 
Cell you chose in Step 1 
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Functions & 
Operators for 
Formulas 
 

Operations follow the order of BEDMAS: 

 Brackets, Exponents, Divide, Multiply, Add, Subtract 
 
Formula Notation for common mathematical functions 

Addition:           + 
Subtraction:      - 
Division:            \ 

Multiplication:    * 
Brackets:          ( ) 
Range:             ... [i.e. A1...A70] 

AutoSum   
 

Automatically Sum 
your Data 
 

Home Tab >> Editing Group >> AutoSum 
 

Excel can automatically, quickly, Add a row or column of 

numbers for you: 
 Select the Cells you want to sum 

 Include an empty Cell as the last Cell in the selection 

 This is where your summation result will be entered 
 Click on the AutoSum Tool in the Editing Group 

 Choose Sum from the list 
 
Several other commonly used Functions are available here such as: 

 Average, Count, Min, Max 
 

To automatically apply the same Function to a Set of Cells 
 Follow instructions to Automatically Fill Data Cells on page 6 above 

Creating and Formatting Charts 

 

 

Inserting a Chart 
from Data 

 
 

Insert Tab >> Charts Group 
 

 Select a set of Data 
o The Data should all be adjacent and arranged in Columns 
o The leftmost Column is Data for the X-Axis 
o Each other Column represents a different Series of Data or Set of Y-Values 

 Choose a Chart Type (Column, Pie, Scatter, etc.) from the Charts Group 
 Or click on Dialog Box Launcher arrow at the right bottom corner of Chart Group 

to launch Insert Chart window 

 Select the type of chart you want 
 
Choose the type of Chart you want. 

 XY (Scatter) is one of the more popular Chart Types for representing data because 
it allows you to alter both the X-axis and the Y-axis 

 There are several other types of charts and each has different options for laying out 
data. See which one works best for your data set 

 
NOTE : 
Excel 2007 has removed the Chart Wizard. You must use the  
Chart Tools Ribbon Tabs to format and alter the appearance and Data of your Chart. 

See instructions below. 
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Chart Tools Tab: 
 
 Design Tab 

 Layout Tab 

 Format Tab 
 

You need to use 
Chart Tools Tabs 

to Format any part 
of the Chart 

 

 
 

1. To Format a Chart, always Select the Chart first by clicking on it. 
2. Chart Tools Tab appears providing the Design Tab, Layout Tab and Format Tab 

for Formatting the selected Chart 

Creating a Chart 
Step 1 

Choose / Change a 
Chart Design 

Chart Tools - Design Tab >> Type Group >> Change Chart Type 

 Click on Change Chart Type Tool to change the type of chart 

 
Choose the type of Chart you want. 

 XY (Scatter) is one of the more popular Chart Types for representing data because 
it allows you to alter both the X-axis and the Y-axis 

 There are several other types of charts and each has different options for laying out 
data. See which one works best for your data set 

Formatting a Chart - Step 2 - Changing the Data Range for a Series 
 

Creating a Chart 
Step 2  

 Choose a Data 
Range 

 Add or Delete a 
Series 

 
Series - a single 

Column of Data 

Chart Tools - Design Tab >> Data Group >> Select Data 
 

NOTE: You only need to use the Select Data Tool if the Chart is NOT displaying the 

correct Data for each Series. 
 

 Click on Select Data button to change the Data Range of each Series of the Chart 
 The Select Data Source window will appear 

 Select a Data Series in the box on the left (Ex. "Jim") 
 Click on Edit button to change the Data in the Series  

o The Edit Series window will appear 
o To choose Data straight off the Excel Sheet, click on the Graph Symbol next  

to the Series Name, X-Values, or Y-Values 

 Click Delete in the Data Source window to Delete a Data Series 
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Creating a Chart  
Step 3 
Edit Chart Titles, 
Labels, Axis and 
Background  

Chart Tools - Layout Tab >> Labels, Axes, & Background Groups 

 

Labels Group:  

 Chart Title / Axis Titles Tools 

o Add, remove and position the titles of the chart and axis 
o To change the Font for a Title, highlight the text and go to the  

Font Group in the Home Tab 

 Legend Tool 
o Add, remove and position the Chart Legend  

o The Legend assigns a separate colour to each Data Series 
 Data Labels Tool 

o Data Labels are the X or Y values for each Data Point in a Series  

o They will appear next to each Data Point Marker in a Series Line  
o Add, remove and position the Data Labels 

 Data Table Tool 

o Add  the Data Table to the chart 
 
Axes Group:  

 Axes Tool - Change the formatting and layout of each axis  

 Gridlines Tool - Turn Major and Minor Gridlines on or off 
 
Background Group: Edit the Background color and style of the chart. 
 
There are more options for all of these Groups.  

 Choose "More options" when you click on a Tool 

 A Format Dialog Box will open for that Tool 
 As you select each option, the Chart Preview will change. If you are unsure of what 

an option will do to your Chart, try clicking on it. You can always turn it off again.  

Creating a Chart  
Step 4 

Chart Location 

Chart Tools - Design Tab >> Location Group >> Move Chart 

 This Tool is located on the far right of the Chart Tools Design Tab 
 Choose whether you want the Chart to appear as an object on the same sheet as 

your data (more common) or on its own sheet 

Stretching the 
Chart 

 

If the Axis Labels are positioned too close together, or the Chart is not the shape you 

want it to be, you can stretch the chart. 

 Click in the blank background of the Chart near the Title. You should see a box 
appear around the entire Chart. 

 Click and drag the “handles” of the box to make the Chart bigger 
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Formatting Parts of a Chart 

 
 
 

There are two methods you can use to Format any part of your Chart 

Format the 

 Font, Colour, Shape, Fill, Outline or Style  
of the  

 Chart Area (background of whole chart), X or Y Axes, Legend,  
Plot Area, Gridlines, Titles, Data Series Lines, or Plot Points 

 
Method 1 

 Right-click on that specific part of the Chart and choose Format ____ ... 
 
Method 2 
Chart Tools - Format Tab >> Current Selection Group 
1. Click on the Chart Elements List.  

o A pull-down menu will list all the elements of your Chart  
o Select the part of the chart that you want to format 

2. Click on the Format Selection button 
o A Format Dialog Box will appear for that element of the chart  

 

Some parts in the chart (i.e. Lines and Plot Points) are easier to select by Method 2 than by right-clicking. 
 
Note: In the sections below, we mainly use the Right-click Method to select an area of the chart. 

Formatting Axes 
Change the Pattern, 
Scale, Font, Number 
Type, and Angle of 
the X and Y Axes.  
 
Of these, the most 
important is the 
Scale of the Axes. 

  
 

Right-click on the X or Y axis in your Chart and choose Format Axis...  
 The Format Axis Dialog Box will open 

 
Set the Axis options: 

 Axis Options - These greatly affect how your data is displayed! 

When the Chart is created, the major values (tick marks) of the axes are set 
automatically, but you might want them to be very different.  
Axis Options allows you to set: 
o Minimum and Maximum value for each axis  
o Major Unit - The increment between major values (tick marks) on the axis 
o Minor Unit - The increment between minor values (smaller tick marks) on the 

axis 
o To change any of these options, click on the Fixed, not Auto setting 

 Number - Change the Type of Data for the axis values (date, time, text...)  

 Fill, Line Colour, Line Style - Change the background color, Axis colour, or Axis 
Line style for the X or Y axis  

 Alignment - Change the direction of the text for the Axis Values 

Chart Elements List 1 
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Formatting a 
Series of Data 
Change the 
appearance of a 
Data Series Line 
and its Markers 

Right-click on the Series Line and choose Format  Data Series...  

 The Format Data Series Dialog Box will open 
 

Set the Data Series options: 

 Series Options - decide whether to place a series on a Primary or Secondary Axis 

 Marker Options and Fill - Change the Marker Shape, Colour, and Size 

 Marker Line Color & Style - Change the Color and Style of the Marker Outline 

 Line Color & Line Style - Change the Colour and Style of the Series Line  

Display and Format 
Data Labels 

Show the Data 
Values 
 
Data Labels 

The X or Y values 
can be displayed 
next to each Data 
Marker in a Series 
Line 

Chart Tools - Layout Tab >> Labels Groups >> Data Labels 
 
To create Data Labels: 
 Select a Series Line 

 Click on the Data Labels Tool in the Labels Group 

 Choose a position for the Data Labels relative to 
their Marker 

 
To show the Format Data Labels Dialog Box: 

 Right-click on a Series Line that has Data Labels and choose  
Format Data Labels...  

 The Format Data Labels Dialog Box will open 

 
Set the Data Labels options: 

 Label Options - Choose which X or Y Value you want the Label to display and 
where you want the Label to be positioned relative to the Series Markers 

 Number - Change the Type of Data for the axis values (date, time, text...)  
 Fill, Border Colour, Border Style - Change the appearance of the Data Label 

 Alignment - Change the direction of the text in the Data Label 

Adding Error Bars 
to a Series of Data 
 
Error Bar 

A small line 
extending from each 
Data Marker that 
represents the 
potential error of 
your data. 

Chart Tools - Layout Tab >> Analysis Group >> Error Bars 
 
To create Error Bars: 

 Select a Series Line  

 Click on the Error Bars Tool in the Analysis 
Group 

 Select the Type of Error Bars you want 
o Standard, Percentage, or Standard Deviation 

 Horizontal and Vertical Error Bars will appear 

on all the Data Markers in that Series Line 
 To Delete Horizontal or Vertical Error Bars, select 

one or the other and hit the Delete Key 
 
To show the Format Error Bars Dialog Box: 
 Select the Error Bars for a Series Line that has them 

 Right-click on an Error Bar and choose Format Error Bars... 

 The Format Error Bars Dialog Box will open 

 
Set the Error Bars options: 

 Vertical / Horizontal  Error Bars 

o Show the Plus, Minus, or Both Error Bars 
o Amount of Error - Fixed, Percentage, Standard Deviation, Standard Error 

 Line Colour, Style - Change the appearance of the Error Bars 
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Creating Trend 
Lines and their 
Equations 

 
Trendline 

The line that best 
represents the 
average of your data 
points. 
 
Excel can provide 
an equation for the 

Trendline 

Chart Tools - Layout Tab >> Analysis Group >> Trendline 
 
To create a Trendline: 

 Select a Series Line 

 Click on the Trendline Tool in the Analysis 
Group 

 Select the type of Trendline you want 
o Linear, Exponential, Linear Forecast 

 A Trend Line will appear on your Chart and be 
added to the Legend 

 
To show the Format Trend Line Dialog Box: 

 Select a Trend Line and Right-click on it (or use the Chart Elements List) 

 Choose Format Trendline... and the Format Trendline Dialog Box will open 

 
Set the Trendline options: 
 Trendline Options 

o Type - Exponential, Linear, Logarithmic, Polynomial, Power,  
o Name - Change the Name of the Trendline in the Legend 
o Check Display Equation on Chart to show the Equation of the Trendline 

 This is one of the most useful features of Excel! 

 Line Color, Style - Change the appearance of the Trendline 

Printing 

Set the Print Area 

of a spreadsheet 

Page Layout Tab >> Page Setup Group >> Print Area 

 
To print ONLY selected data 
 Select an area of Data in the Data Sheet 

you want to print 
 Click on the Print Area Tool in the Page 

Setup Group  
 Choose Set Print Area 

 
MS Office Button >> Print 

 Click on OK to print the Print Area 

Preview the  

print-out 

MS Office Button >> Print 

 Place the mouse over Print to see more options 

 Choose Preview from the list in the right side of the MS Office Box 

 
NOTE: You may find that you need to set the Page Orientation to Landscape 
(Horizontal) to make your Data Sheet fit properly. Printing that spans several pages is 
available for larger spreadsheets. 

 
This tutorial covers the basic features of Excel. This handout can be used as a general reference tool. If you 
require further assistance, especially in creating Formulas, please ask Staff for assistance with any other 
aspect of Excel. Formula tutorials can also be found in Excel's Help or online.  

 

Thank you for attending our Microsoft Office tutorial series. 
 

This tutorial series was originally developed by the E-Learning Systems Group (ESG) 
at UVic and has been expanded and re-written for use in the Student Computing Facilities. 


